Пример 10: Течение в каталитическом конвертере 

Руководство
Это руководство включает в себя:
· Возможности примера 10
· Общее представление о проблемах решателя
· Описание процесса симуляции в ANSYS CFX-Pre
· Получение решения с помощью ANSYS CFX-Solver Manager
· Визуализация результатов в ANSYS CFX-Post
Перед тем как запустить файл сессии, скопируйте файлы для примера из папки C:\Program Files\ANSYS Inc\v110\CFX\examples в Вашу рабочую директорию.
Вам потребуется скопировать следующие файлы:
· CatConv.pre
· CatConvHousing.hex
· CatConvMesh.gtm
Возможности Примера 10
Этот пример использует следующие возможности ANSYS CFX.
	Component
	Feature
	Details

	ANSYS CFX-Pre
(Препроцессор)
	User Mode 
(Пользовательский режим)
	General Mode 
(Основной режим)

	
	Simulation Type
(Тип симуляции)
	Steady State 
(Стационарный)

	
	Fluid Type
(Тип жидкой среды)
	Ideal Gas
(Идеальный газ)

	
	Turbulence Model
(Модель турбулентности)
	k-Epsilon

	
	Heat Transfer
(Перенос тепла)
	Isothermal
(Изотермический)

	
	Subdomains
(Поддомены)
	Resistance Source
(Источник сопротивления)

	
	Boundary Conditions
(Граничные условия)
	Inlet (Subsonic) 
Вход (дозвуковой)

	
	
	Outlet (Subsonic) 
Выход (дозвуковой)

	
	
	Wall: No-Slip 
Стенка: Без скольжения

	
	Domain Interfaces
(Интерфейс домена)
	Fluid-Fluid (No Frame Change)
Жидкость-Жидкость (Без изменения каркаса)

	
	Timestep
(Шаг по времени)
	Physical Time Scale
(Физическая шкала по времени)

	ANSYS CFX-Post
(Постпроцессор)
	Plots
(Схемы)
	Contour (Контур)

	
	
	Default Locators (Участки по умолчанию)

	
	
	Outline Plot (Wireframe) 
Каркас

	
	
	Polyline (Полилиния)

	
	
	Slice Plane (Плоскость слоя)

	
	
	Vector (Вектор)

	
	Other
(Другое)
	Chart Creation (Создание диаграммы)

	
	
	Data Export (Экспорт данных)

	
	
	Title/Text (Заголовок/Текст)

	
	
	Viewing the Mesh (Просмотр сетки)


В этом руководстве Вы изучите:

· Использовать составную сетку в ANSYS CFX-Pre.

· Соединять сетки вместе с помощью статический интерфейс домена типа жидкость-жидкость в местах соединения входа/выхода и центрального тела катализатора. 

· Применять источник сопротивления с помощью модели направленных потерь.

· Создавать диаграмму, показывающую понижение давление в домене в ANSYS CFX-Post.

· Экспорт данных из линейной области (line locator?) в файл.

Общее представление о проблемах решателя
Каталитические конвертеры сегодня используются в большинстве транспортных средств на дороге. Они уменьшают вредную эмиссию из внешнего двигателя внутреннего сгорания (такую, как окись азота, углеводорода и одноокиси углерода), которая является результатом неполного сгорания. Большинство новых каталитических конвертеров относятся к типу (honeycomb ceramic) и обычно покрыты платиной, are usually coated with platinum, родием или палладием. Выхлопы газов внутри сотовых структур и градиент давления установлены между входом и выходом. 
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В этом примере каталитический конвертер является моделью без надлежащего химического реактора, чтобы установить (ограничить) падение давления. Входной фланец (соединяющий трубку с катализатором) предназначен для равномерного распределения выхлопных газов через каталитический материал. 

Сетка для этого примера гексаэдрическая, бала создана в ICEM-Hexa.

Различные сетки будут соединены вместе в ANSYS CFX-Pre. Вы импортируете каждую сетку и создадите домен, объединит их. Внутри конвертера будет создан поддомен, чтобы смоделировать сотовую (honeycomb) структуру с помощью модели направленных потерь.
Описание симуляции в препроцессоре ANSYS CFX-Pre 

Проигрывание файла сессии 

Чтобы настройки симуляции выполнились автоматически, Вы можете запустить файл сессии. Для этого выберите в главном меню пункт Session > Play Tutorial (Сессия > Проиграть сессию из руководства), затем выберите файл сессии CatConv.pre. 

Создание новой симуляции 

1. Запустите ANSYS CFX-Pre.

2. Выберите File > New Simulation (Файл > Новая симуляция). 

3. Выберите General в диалоговом окне с названием New Simulation File и нажмите OK. 

4. Выберите File > Save Simulation As (Файл > Сохранить симуляцию как…). 

5. В поле ввода File name задайте имя CatConv и нажмите Save (Сохранить). 

Импорт сетки  
Каталитический конвертер состоит из 3 отдельных частей:

· Входная часть (трубка и фланец).

· Выходная часть (трубка и фланец).

· Катализатор (или монолит).

Далее Вы будете импортировать части входа/выхода и корпус катализатора из готовых файлов.

Корпус 

Первой Вы будете импортировать сетку для корпуса катализатора. Она состоит из гексаэдров, была создана в ICEM-Hexa, и называется файл CatConvHousing.hex. При создании этой сетки были указаны единицы измерения сантиметры; однако единицы измерения не сохраняются вместе с сеткой в файле для сетки этого формата. Вы должны сами задать единиц измерения сантиметры при импорте сетки в ANSYS CFX-Pre, чтобы сохранить верный размер. Импортируемая сетка имеет ширину по оси x 21 cm и длну по оси z 20 cm. 

1. Нажмите правой кнопкой мыши на вкладке Outline на пункт Mesh и выберите Import Mesh. 

2. Примените следующие настройки
	Настройки
	Значение

	File type
	All Types

	Definition > Mesh Format
	ICEM CFD

	File name
	CatConvHousing.hex

	Definition > Mesh Units
	cm


3. Нажмите Open. 

Части трубки и фланца 
В этой сетке также используются единицы измерения сантиметры. При импорте из GTM-файла, используйте единицы измерения, указанные в нем.

1. Нажмите правой кнопкой мыши на вкладке Outline на пункт Mesh и выберите Import Mesh. 

2. Примените следующие настройки
	Настройки
	Значение

	File type
(Тип файла)
	CFX Mesh (gtm)

	File name
(Имя файла)
	CatConvMesh.gtm


3. Нажмите Open (Открыть). 

Вам необходимо импортировать сетку только один раз, так как после Вы ее скопируете и повернете фланец на 180 градусов, чтобы создать трубку и фланец для входа. 

Применение трансформации 

Трубка и фланец распложены со стороны выхода корпуса. Повернем фланец  около оси, которая указывает направление y и расположена по центру корпуса. 

1. Нажмите правой кнопкой мыши на CatConvMesh.gtm и выберите пункт Transform Mesh (Трансформация сетки). Появится окно редактора трансформации сетки Mesh Transformation Editor. 

2. Примените следующие настройки
	Вкладка
	Настройки
	Значение

	Definition
(Описание)
	Apply Rotation > Rotation Option
(Применить вращение > Опции вращения)
	Rotation Axis
(Оси вращения)

	
	Apply Rotation > From (Из)
	0, 0, 0.16

	
	Apply Rotation > To (В)
	0, 1, 0.16

	
	Apply Rotation > Rotation Angle (Угол вращения)
	180 [degree]

	
	Multiple Copies (Составные копии) 
	(Поставьте галочку)

	
	Multiple Copies > # of Copies (Число копий)
	1


3. Нажмите OK. 

Создание объединения регионов 

Сейчас объект состоит из трех раздельных регионов. Т.к. нет движения регионов относительно друг друга, то Вам необходимо создать один домен. Это можно сделать просто, используя все три региона в домене из списка Location, или, как в нашем случае, используя дополнительные опции пункта Region для создания объединения трех регионов. 

1. Создайте новый составной регион с именем CatConverter. 

2. Примените следующие настройки
	Вкладка
	Настройки
	Значение

	Basic Settings
(Основные настройки)
	Dimension (Filter)
Измерение (Фильтр)
	3D

	
	Region List
(Список регионов)
	B1.P3, B1.P3 2, LIVE


3. Нажмите OK.

Creating the Domain 

В этом примере Вы будете использовать изотермическую модель переноса тепла и предположение турбулентного течения.

1. Создайте домен с именем CatConv. 

2. Примените следующие настройки
	Вкладка
	Настройки
	Значение

	General Options
(Общие настройки)
	Basic Settings > Location
(Основные настройки > Участок)
	CatConverter

	
	Basic Settings > Fluid List
(Список жидких сред)
	Air Ideal Gas
(Идеальный газ)

	
	Domain Models > Pressure > Reference Pressure
(Относительное давление)
	1 [atm]

	Fluid Models
(Модель расчета течения жидкой среды)
	Heat Transfer > Option
(Перенос тепла > Опции)
	Isothermal
(Изотермический)

	
	Heat Transfer > Fluid Temperature
(Перенос тепла > Температура среды)
	600 [K]


3. Нажмите OK. 

Создание поддомена для модели каталитической структуры
Структура сотовых пузырей (honeycomb) будет смоделирована с помощью поддомена с направленным источником сопротивления.

Для квадрата сопротивлений давление падает следующим образом:
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	Уравнение 1. 


где [image: image4.png]


- коэффициент квадрата сопротивления (quadratic resistance coefficient), [image: image5.png]


- скорость (local velocity) в направлении i, и [image: image6.png]Pl



 - градиент падения давления по направлению i. 

1. Выберите пункт Insert > Subdomain (Вставить > Поддомен) из главного меню или нажмите кнопку Subdomain.
2. В диалоговом окне Insert Subdomain (Вставка поддомена) напишите catalyst. 

3. Примените следующие настройки
	Вкладка
	Настройки
	Значение

	Basic Settings
(Основные настройки)
	Location
(Участок)
	LIVE[a]

	Sources[b]
(Источники)
	Sources
(Источники)
	(Поставьте галочку)

	
	Sources > Momentum Source/Porous Loss 
Источник момента/Потери пористости
	(Поставьте галочку)

	
	Sources > Momentum Source/Porous Loss > Directional Loss
(Направленные потери)
	(Поставьте галочку)

	[a] Это корпус полностью. 

[b] Используется, чтобы задать источники момента, сопротивления и масс для поддомена (Другие источники доступны для прочих задач физики). 


4. Примените следующие настройки в разделе Directional Loss (Направленные потери) 

	Настройки
	Значение

	Streamwise Direction > X Component
Напраление образа линии > Компонента X
	0

	Streamwise Direction > Y Component
	0

	Streamwise Direction > Z Component
	1

	Streamwise Loss > Option (Опции)
	Linear and Quadratic Coefs

	Streamwise Loss > Quadratic Resistance Coefficient
(Коэффициент квадрата сопротивления)
	(Поставьте галочку)

	Streamwise Loss > Quadratic Resistance Coefficient > Quadratic Coefficient
(Коэффициент квадрата сопротивления)
	650 [kg m^-4]


5. Нажмите OK. 

Создание граничных условий 

Входное граничное условие
1. Создайте новое граничное условие с именем Inlet. 

2. Примените следующие настройки
	Вкладка
	Настройки
	Значение

	Basic Settings
(Основные настройки)
	Boundary Type (Тип границы)
	Inlet (Вход)

	
	Location (Участок)
	PipeEnd 2
(Конец трубки 2)

	Boundary Details
(Детали)
	Mass and Momentum > Normal Speed
(Уравнения масс и момента > Нормальная скорость)
	25 [m s^-1]


3. Нажмите OK. 

Выходное граничное условие 

1. Создайте новое граничное условие с именем Outlet. 

2. Примените следующие настройки
	Вкладка
	Настройки
	Значение

	Basic Settings
(Основные настройки)
	Boundary Type (Тип границы)
	Outlet (Выход)

	
	Location (Участок)
	PipeEnd
(Конец трубки)

	Boundary Details
(Детали)
	Mass and Momentum > Option
(Уравнения масс и момента > Опции)
	Static Pressure
(Статическое давление)

	
	Mass and Momentum > Relative Pressure
(Уравнения масс и момента > Относительное давление)
	0 [Pa]


3. Нажмите OK. 

Для остальных поверхностей автоматически применяются граничные условия по умолчанию: стенка без прилипания.

Создание интерфейса домена 

Интерфейс домена используется для описания связующих границ между сетками, где поверхности различны или где происходит изменение каркаса. Сетки «склеиваются» вместе с помощью функции основного интерфейса сеток General Grid Interface (GGI) ANSYS CFX. Могут быть созданы различные типы соединений GGI. В нашем случае, Вам необходим простой тип соединения Fluid-Fluid Static (без изменения каркаса Frame Change). Другие опции позволяют Вам изменять каркас на пересечении интерфейсов или создать периодические границы с неоднородными сетками на каждой из периодических поверхностей. 

Необходимо создать два интерфейса: один – для соединения входного фланца с катализатором, другой – для соединения выходного фланца с корпусом катализатора. 

Входная трубка/ Корпус 

1. Создайте новый интерфейс домена с именем InletSide. 

2. Примените следующие настройки
	Вкладка
	Настройки
	Значение

	Basic Settings
(Основные настройки)
	Interface Side 1 > Region List
(Сторона интерфейса 1 > Список регионов)
	FlangeEnd 2

	
	Interface Side 2 > Region List
(Сторона интерфейса 2 > Список регионов)
	INLET


3. Нажмите OK. 

Выходная трубка/ Корпус 

1. Создайте новый интерфейс домена с именем OutletSide. 

2. Примените следующие настройки
	Вкладка
	Настройки
	Значение

	Basic Settings
	Interface Side 1 > Region List
	FlangeEnd

	
	Interface Side 2 > Region List
	OUTLET


3. Нажмите OK. 

Настройка начальных значений 

Целесообразно задать разумную начальную скорость, чтобы ожидать скорость внутри катализатора. Скорость на входе зададим равной 25 [m s^-1] и в области пересечния входной трубки и корпуса также известно, Вы можете воспользоваться законом сохранения масс, чтобы подсчитать приблизительную скорость в 2 [m s^-1] внутри корпуса. 

1. Нажмите Global Initialization (Глобальная инициализация) [image: image7.png]


.
2. Примените следующие настройки
	Вкладка
	Настройки
	Значение

	Global Settings
(Глобальные настройки)
	Initial Conditions > Cartesian Velocity Components > Option
(Условия инициализации > Компоненты вектора скорости > Опции)
	Automatic with Value
(Автоматически со значением)

	
	Initial Conditions > Cartesian Velocity Components > U
(Условия инициализации > Компоненты вектора скорости > U)
	0 [m s^-1]

	
	Initial Conditions > Cartesian Velocity Components > V
	0 [m s^-1]

	
	Initial Conditions > Cartesian Velocity Components > W
	-2 [m s^-1]

	
	Initial Conditions > Turbulence Eddy Dissipation
(Условия инициализации > Рассевание вихревого движения)
	(Поставьте галочку)


3. Нажмите OK. 

Настройки параметров решателя 

Если учитывать, что скорости на входе и выходе составляют 25 [m s^-1] и 2 [m s^-1] в самом катализаторе, то время расчета равно 0.1 [s]. Удобный шаг по времени равен 0.04 [s] (от 1/4 до 1/2 времени пребывания жидкой среды). 

В качестве значения для критерия сходимости RMS укажем 1e-05. 

1. Нажмите Solver Control (Контроль решателя) [image: image8.png]


.
2. Примените следующие настройки
	Вкладка
	Настройки
	Значение

	Basic Settings
(Основные настройки)
	Convergence Control > Fluid Timescale Control > Timescale Control
(Управление сходимостью > Управление шагом по времени в жидкой среде > Управление шагом по времени)
	Physical Timescale
(Физический шаг по времени)

	
	Convergence Control >Fluid Timescale Control > Physical Timescale
(Физический шаг по времени)
	0.04 [s]


3. Нажмите OK. 

Запись файла для решателя (.def) 

Поскольку в этом примере используются интефейсы домена и выбран переключатель Summarize Interface Data (Суммарные данные интерфейсов), то в информационном окне отобразится сообщение о том, что Вы связываете типы, используя для каждого интерфейс домена. 

1. Нажмите Write Solver File (Записать файл для решателя) [image: image9.png]


. 
2. Примените следующие настройки:

	Параметр
	Значение

	File name
(Имя файла)
	CatConv.def

	Summarize Interface Data
	(Поставьте галочку)

	Quit CFX–Pre[a]
(Закрыть CFX–Pre)
	(Поставьте галочку)

	[a] Если запустили ANSYS CFX-Pre из ANSYS CFX-.11.0 Laucher.  


3. Убедитесь что выбран пункт Start Solver Manager (Запустить Менеджер задач) и нажмите Save (Сохранить).  

4. Если вы получили сообщение о том, что файл уже существует, нажмите Overwrite (Перезаписать). 

5. Нажмите Yes (Да) или Save & Quit (Сохранить и закрыть приложение), чтобы сохранить файл с расширением (.cfx). 

Получение решения с помощью ANSYS CFX-Solver Manager
Когда завершится приложение ANSYS CFX-Pre и запустится ANSYS CFX-Solver Manager для получения решения.
1. Нажмите Start Run (Запустить расчет). 

2. Нажмите Yes, чтобы увидеть результаты в постпроцессоре ANSYS CFX-Post. 

3. Закройте ANSYS CFX-Solver Manager.

Просмотр результатов в постпроцессоре ANSYS CFX-Post 

Когда откроется ANSYS CFX-Post, измените соответствующим образом величину угла Edge Angle в настройках каркаса Wireframe. 

На вкладке Outline доступны сразу несколько интерфейсов. Два отношения между корпусом катализатора и входной/выходной трубками имеют по два интерфейса, для каждой из сторон связи. 

1. Измените размер объекта в окне просмотра.

2. На вкладке Outline дерева просмотра измените настройки объекта InletSide Side 1. 

3. Примените следующие настройки
	Вкладка
	Настройки
	Значение

	Render
(Отображение)
	Draw Faces
(Отобразить поверхность)
	(Удалите галочку)

	
	Draw Lines
(Отобразить линии)
	(Поставьте галочку)

	
	Draw Lines > Color Mode
(Цветовой режим)
	User Specified
(Пользовательский)

	
	Draw Lines > Line Color
(Цвет линий)
	(Красный)


4. Нажмите Apply (Применить). 

5. На вкладке Outline дерева просмотра измените настройки объекта InletSide Side 2. 

6. Примените следующие настройки
	Вкладка
	Настройки
	Значение

	Render
	Draw Faces
	(Удалите галочку)

	
	Draw Lines
	(Поставьте галочку)

	
	Draw Lines > Color Mode
	User Specified

	
	Draw Lines > Line Color
	(Зеленый)


7. Нажмите Apply (Применить). 

8. Скройте каркас Wireframe. 

9. Нажмите правой кнопкой мыши в окне просмотра и выберите Predefined Camera > View Towards – Z (Расположение камеры > Просмотр по направлению оси Z). 

Сейчас Вы видите татраэдрическую/призматическую и гексаэдрическую сетки на каждой из сторон интерфейса. Возможность основного интерфейса сеток General Grid Interface (GGI) ANSYS CFX была использована, чтобы обеспечить связь между этими двумя неоднородными сетками перед решением. Заметим, что элементом тетраэдров и призм больше, чем гексаэдров и что объем, величина, пространство, протяженность (extent) двух сеток не одинаков (это сильнее заметно на изогнутых границах). Протяженность каждой из сторон интерфейса неодинакова, поэтому необходимо создавать связь GGI. 

Создание участков и графиков 

1. На вкладке Outline дерева просмотра выберите Wireframe и отобразите его. 

2. На вкладке Outline дерева просмотра скройте оба объекта InletSide Side 1 и InletSide Side 2. 

Создания плоскости слоя 

1. Создайте новую плоскость с именем Plane 1. 

2. Примените следующие настройки
	Вкладка
	Настройки
	Значение

	Geometry
(Геометрия)
	Definition > Method
(Описание > Метод)
	ZX Plane
(Плоскость ZX)

	Color
(Цвет)
	Mode (Режим)
	Variable
(Переменная)

	
	Variable (Переменная)
	Pressure
(Давление)


3. Нажмите Apply (Применить). 

4. Нажмите правой кнопкой мыши в окне просмотра и выберите Predefined Camera > View Towards – Y (Расположение камеры > Просмотр по направлению оси Y).
Создание графика контура 

Давление падает монотонно внутри корпуса каталитического конвертера. Вы можете увидеть это с помощью контурного графика.

1. Скройте Plane 1 на вкладке Outline. 

2. Создайте новый контур с именем Contour 1. 

3. Примените следующие настройки
	Вкладка
	Настройки
	Значение

	Geometry
	Locations
	Plane 1

	
	Variable
	Pressure

	
	# of Contours
	30

	Render
	Draw Faces
	(Удалите галочку)


4. Нажмите Apply (Применить).
Создание векторного графика с помощью плоскости слоя 

1. Создайте новый векторный график с именем Vector 1. 

2. Примените следующие настройки
	Вкладка
	Настройки
	Значение

	Geometry
(Геометрия)
	Locations
(Участки)
	Plane 1

	Symbol
(Символ)
	Symbol Size
(Размер символа)
	0.1

	
	Normalize Symbols
(Нормализовать символ)
	(Поставьте галочку)


3. Нажмите Apply (Пример). 

Заметим, что течение разделяется у стенки, где входная трубка переходит во фланец, устанавливается зона рециркуляции. Течение одинаково внутри корпуса катализатора. 

Предположим, что Вы хотите увидеть график падения давления по оси Z. В этом случае, Вы можете построить график с помощью ANSYS CFX-Post, а также экспортировать данные, чтобы затем их считать в любом стандартном пакете построения диаграмм. 

Диаграммы создаются с помощью объекта chart (Диаграмма), но перед тем как Вы создадите диаграмму, Вы должны описать точки, в которых требуется узнать данные. Для задания этих точек, можно использовать объект полилиния. 

Создание полилинии 

Полилиния может быть создана несколькими методами: из файла (From File), пересечением границ (Boundary Intersection) или из контура (From Contour). Если Вы выбрали метод From File, у Вас должен быть файл, содержащий описание точек в соответствующем формате. 

В этом примере Вы воспользуетесь методом пересечения границ Boundary Intersection method. Он позволит создать полилинию как линию пересечения между объектами границ и участками (например, между стенкой и плоскостью). На полилинии отмечены точки, в которых пересекаемая линия разрезается краем поверхности сетки. 

Вы увидите полилинию линию как пересечения между стенкой, входной и выходной границами и плоскостью.
1. На вкладке Outline дерева просмотра скройте Contour 1 и Vector 1. 

2. Создайте новую полилинию с именем Polyline 1. 

3. Примените следующие настройки
	Вкладка
	Настройки
	Значение

	Geometry
(Геометрия)
	Method
(Метод)
	Boundary Intersection
(Пересечение границ)

	
	Boundary List
(Список границ)
	CatConv Default, Inlet, Outlet[a]

	
	Intersect With
(Пересечение с)
	Plane 1

	Color (Цвет)
	Color (Цвет)
	(Желтый)

	Render
(Отображение)
	Line Width
(Ширина линии)
	3

	[a] Нажмите the ellipsis icon to select multiple items using the <Ctrl> key. 


4. Нажмите Apply (Применить). 

5. Нажмите правой кнопкой мыши в окне просмотра и выберите Predefined Camera > Isometric View (Y up) (Расположение камеры > Просмотр изометрично оси Y). 
Создание диаграммы 

Полилиния была описана выше, сейчас можно создать диаграмму. Диаграммы состоит из нескольких линий. Линии диаграммы перечисляются в дереве просмотра под тем объектом диаграммы, к которому они принадлежат. 

1. Создайте новую диаграмму с именем Chart 1. 

2. Примените следующие настройки
	Вкладка
	Настройки
	Значение

	Chart
(Диаграмма)
	Title
(Заголовок)
	Pressure Drop through a Catalytic Converter
(Падение давления внутри каталитического конвертера)

	Chart Line 1
(Линия 1)
	Line Name
(Название линии)
	Pressure Drop
(Падение давления)

	
	Location
(Участок)
	Polyline 1

	
	X Axis > Variable
(Ось X > Переменная)
	Z

	
	Y Axis > Variable
(Ось Y > Переменная)
	Pressure
(Давление)

	
	Appearance > Symbols
(Появление > Символы)
	Rectangle
(Прямоугольник)

	Appearance
(Появление)
	Sizes > Line
	3


3. Нажмите Apply (Применить). 

Вы можете заметить, что внутри катализатора давление падает линейно. Например,  в регионе от Z=0.05 до Z=0.25. Две линии показывают давление на каждой из сторон стенки. Вы можете увидеть заметные различия давления между двумя стенками на стороне корпуса с входа (около Z=0.25). 

4. Если это необходимо, выберите на вкладке Outline объекты Contour 1, Polyline 1, и Vector 1. 

5. Нажмите правой кнопкой мыши в окне просмотра и выберите Predefined Camera > View Towards +Y (Расположение камеры > Просмотр по направлению оси Y). 

Вы увидите, что течение входит в катализатор из входной трубкипод небольшим углом, создавая высокое давление на верхнюю часть стенки корпуса по оси X. 

6. Под пунктом Report (Отчет) располагается объект Chart 1 (Диаграмма), выберите для правки Chart Line 1. 

7. Примените следующие настройки
	Вкладка
	Настройки
	Значение

	Chart Line 1
(Линия на диаграмме 1)
	X Axis > Variable
(Ось X > Переменная)
	Chart Count[a]
(Вычисление)

	[a] Это число точек с данными (например, 1,2,3,4...), это НЕ отражает расстояния между каждой из точек на полилинии. 


8. Нажмите Apply (Применить). 

Экспорт данных 

1. Выберите в главном меню пункт File > Export (Файл > Экспорт). 

2. Примените следующие настройки
	Вкладка
	Настройки
	Значение

	Options
(Опции)
	Locations
(Участок)
	Polyline 1

	
	Export Geometry Information
(Экспорт информации о геометрии)
	(Поставьте галочку)[a]

	
	Select Variables
(Выбрать переменные)
	Pressure
(Давление)

	Formatting
(Форматирование)
	Precision
(Точность)
	3

	[a] Это обеспечит сохранение X, Y и Z в выходном файле. 


3. Нажмите Save (Сохранить). 

Файл export.csv будет записан в текущую рабочую директорию. Этот файл может быть открыт в любом текстовом редакторе. Вы можете воспользоваться экспортируемыми данными для построения диаграмм в других приложениях. 

4. Когда завершите работу, закройте ANSYS CFX-Post.
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